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Section 1 - Product Overview

• D-Link DCS-5220 Wireless PTZ Network Camera 
with 3G Mobile Video Support

• CAT5 Ethernet Cable
• Power Adapter
• Antenna
• Manual and Software on CD
• Quick Install Guide
• Camera Stand

Note: Using a power supply with a different voltage than the one included 
with your product will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements
•	Windows® XP or Windows® Vista
•	At least 256MB of memory (512MB recommended)
•	A wireless (802.11b or 802.11g) or Ethernet network
•	Internet browser 6.x or higher Internet Web Browser
•	VGA card resolution: 800x600 or above
•	CPU: 1.3GHz or above processor (2.4GHz processor or higher with 512MB memory and a 32MB video 

card is required for multiple camera viewing and recording in IP surveillance program)

Package Contents
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Introduction
The D-Link SECURICAM Network DCS-5220 Wireless PTZ Network Camera is a powerful surveillance system that 
connects wirelessly to your 802.11b/g network. The DCS-5220 features enhanced 802.11b/g and connects wirelessly 
at a rate of up to 54Mbps1  (Megabits per second). The DCS-5220 differs from a conventional PC Camera because it is 
a standalone system with a built-in CPU and Web server, providing a low-cost solution capable of solving demanding 
security and home/office monitoring needs. Snapshot enables you to save images directly from a Web browser to a 
local hard drive without installing any additional software. With 1 lux light sensitivity, the DCS-5220 is capable of 
capturing video in rooms with minimal lighting. You can also zoom in with the DCS-5220’s 4x digital zoom2 feature. 
The DCS-5220 gives you the ability to monitor video and audio in your home/office using an Internet browser from any 
where in the world! Simple installation procedures, along with the built-in Web-based interface offers easy integration 
to your network environments. 

Customers also have the ability to view live video streams from a compatible 3G cell phone. The live camera feed of 
the D-Link Wireless PTZ Network Camera can be pulled from the 3G cellular network by using a compatible cell phone 
with a 3G video player3. From anywhere within the 3G service area, both consumers and small businesses are offered 
a flexible and convenient way to remotely monitor a home or office in real time.

Note: Use of audio or video equipment for recording the image or voice of a person without their knowledge and consent 
is prohibited in certain states or jurisdictions. Nothing herein represents a warranty or representation that the D-Link 
product provided herein is suitable for the end-user’s intended use under the applicable laws of his or her state. D-Link 
disclaims any liability whatsoever for any end-user use of the D-Link product, which fails to comply with applicable 
state, local, or federal laws.

1 Maximum wireless signal rate derived from IEEE Standard 802.11b/g specifications. Actual data throughput will vary. Network conditions and environmental factors 
lower actual data throughput rate.

2 4x digital zoom enlarges an image by magnifying the pixels in a selected portion of the image by 4 times.

3 3G phone must be equipped with 3G video playback such as RealPlayer® or PacketVideo for Symbian or PocketPC.
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•	3G Compatibility: Offers customers the ability to view live video streams from a compatible 3G cell phone. The 
live camera feed can be pulled from a 3G cellular network by using a compatible cell phone with a 3G video 
player.

•	Supports a Variety of Platforms: Supporting TCP/IP networking, SMTP e-mail, HTTP and other Internet related 
protocols, the DCS-5220 Network Camera can be integrated into other Internet/Intranet applications because 
of its standards-based features.

•	Remote Snapshot Images/ Video Clip: You can save snapshots/video clips directly from the Web browser to a 
local hard drive without installing any additional software, making it convenient to instantly capture any moment 
from a remote location.

•	Low Light Recording and 4x Digital Zoom: The DCS-5220’s 0.5 lux light sensitivity allows you to capture video 
in rooms with minimal lighting, making it ideal for use at night time. The camera also features 4x digital zoom 
for closer viewing.

•	Web Configuration: Using the Internet browser, administrators can configure and manage the Network Camera 
directly from its own Web page via the Intranet or the Internet. Up to 20 user names and passwords are 
permitted, with privilege settings controlled by the administrator.

•	Powerful Surveillance and Remote Monitoring Utility: The powerful D-ViewCam software allows an administrator 
to modify the Network Camera settings from a remote site via the Intranet or the Internet. Administrators are 
capable of monitoring live video feeds as well as recording video and taking snapshots.

•Variety Data Archive: Record video clips directly onto a Network Attached Storage (NAS) or to a network-based 
computer. The DCS-5220 allows you to schedule both recorded video and snapshots to be uploaded onto an 
FTP server or sent via e-mail.

•	Broad Range of Applications: With today’s high-speed Internet, the Network Camera provides the ideal solution 
for live video images over the Intranet and Internet for remote monitoring. The DCS-5220 allows remote access 
from an Internet browser for live image viewing with audio and allows the administrator to manage and control 
the Network Camera anywhere and any time. Apply the Network Camera to monitor various objects and places such 
as homes, offices, banks, hospitals, child-care centers, amusement parks and other varieties of industrial and public 
monitoring. The Network Camera can also be used for intruder detection with its motion-detection mode, capture 
still images and video images for archiving and many more applications. The wireless capability enables you 
to place the camera where it is inconvenient to install network cables.

Features
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Hardware Overview
Antenna Connector
One antenna is included with the DCS-5220. It is fastened onto the antenna connector located on 
the back panel, which is used to provide a connection with a wireless network.

Power LED
As soon as the power Adapter is connected to the camera, the red LED and the green LED light will both appear 
steady on. As the camera is booting, a flashing red LED and steady green LED light will appear next. 

The red LED will be turned off during self-test. Upon passing the self-test, a steady red LED and flashing 
green LED light will appear, indicating a good connection to the Ethernet port.

Microphone
The DCS-5220 Network Camera has a built-in internal 
microphone. 
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Ethernet Cable Connector
The DCS-5220 features a RJ-45 connector for connections to 10Base-T Ethernet cabling or 100Base-TX Fast 
Ethernet cabling. The port supports the NWay protocol, allowing the DCS-5220 to automatically detect or negotiate 
the transmission speed of the network.

Reset / Restore Button
Press this button to reset or restore the DCS-5220, please see page 104 
for detail.

DC Power Connector
The DC Power input connector is labeled DC 12V with a single jack 
socket to supply power to the DCS-5220.



9D-Link DCS-5220 User Manual

Section 1 - Product Overview

Hardware Installation
Connect an Ethernet cable to the Ethernet connector located on the Network Camera’s 
back panel and attach it to the network.

Note: It is required that an Ethernet cable is used during initial setup. Once your wireless 
configuration is set, you may disconnect the Ethernet cable and begin communicating 
wirelessly with your DCS-5220.

Attach the external power supply to the DC power input connector located on the 
Network Camera’s back panel (labeled DC 12V) and connect it to an AC power 
outlet.
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Wireless Installation Considerations
The D-Link Wireless PTZ Network Camera lets you access your network using a wireless connection from virtually 
anywhere within the operating range of your wireless network. Keep in mind, however, that the number, thickness and 
location of walls, ceilings, or other objects that the wireless signals must pass through, may limit the range. Typical 
ranges vary depending on the types of materials and background RF (radio frequency) noise in your home or business. 
The key to maximizing wireless range is to follow these basic guidelines:

1.	Keep the number of walls and ceilings between the D-Link adapter and other network devices to a 
minimum - each wall or ceiling can reduce your adapter’s range from 3-90 feet (1-30 meters.) Position 
your devices so that the number of walls or ceilings is minimized.

2.	Be aware of the direct line between network devices. A wall that is 1.5 feet thick (.5 meters), at a 
45-degree angle appears to be almost 3 feet (1 meter) thick. At a 2-degree angle it looks over 42 feet 
(14 meters) thick! Position devices so that the signal will travel straight through a wall or ceiling (instead 
of at an angle) for better reception.

3.	Building Materials make a difference. A solid metal door or aluminum studs may have a negative effect on 
range. Try to position access points, wireless routers, and computers so that the signal passes through 
drywall or open doorways. Materials and objects such as glass, steel, metal, walls with insulation, water 
(fish tanks), mirrors, file cabinets, brick, and concrete will degrade your wireless signal.

4.	Keep your product away (at least 3-6 feet or 1-2 meters) from electrical devices or appliances that 
generate RF noise.

5.	If you are using 2.4GHz cordless phones or X-10 (wireless products such as ceiling fans, lights, and 
home security systems), your wireless connection may degrade dramatically or drop completely. Make 
sure your 2.4GHz phone base is as far away from your wireless devices as possible. The base transmits 
a signal even if the phone in not in use.
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D-Link Click’n Conenct (DCC)
DCC will show the MAC address and IP address of your DCS-5220. If you have a DHCP* server on your network, there 
will be a valid IP Address displayed at the end of DCC process. You can begin to use the Network camera now.

*A DHCP server is a device that supplies IP Addresses to its 
clients that are on the same network.

Configuration
Turn on the computer and Insert the D-Link DCS-5220 Driver CD in the CD-ROM drive. The step-by-step instructions 
will help you to search and setup your Network camera smoothly and quickly.

If the CD Autorun function does not automatically start on your computer, click Windows® Start > Run. In the Run 
command box type “D:\DCS5220.exe”, where D: represents the drive letter of your CD-ROM. If it does start, proceed 
to the next screen.

Click Start
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UPnP (Universal Plug and Play) is a networking architecture that provides 
compatibility among networking equipment, software, and peripherals. The 
DCS-5220 is an UPnP enabled Network Camera. If your operating system is 
UPnP enabled, the device will be easier to configure. If you do not want to use 
the UPnP functionality, it can be disabled by unchecking the Enabled UPnP 
checkbox in the Advanced > Network page (see page 32). Use the following 
steps to enable UPnP settings only if you are running Windows® XP or above. If 
you are running Windows® 98/2000, UPnP is not available.

Go to Start > Settings. Click Control Panel.

Enabling UPnP for Windows® XP, Vista (Optional)

Click Add or Remove Programs
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The following screen will appear. 

Select Networking Services.

Select Universal Plug and Play. 

Click Details

Click Add/Remove Windows Components

Click OK
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Please wait while Setup configures the components.

Click Next

Click Finish
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To view your DCS-5220 Network Camera in an Internet browser, 
go to your Desktop and click My Network Places.

Click DCS-5220 (192.168.0.120).  
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After you click on the DCS-5220 icon, your Internet browser will 
automatically be opened to the IP Address of the DCS-5220, 
in this example it is: http://192.168.0.120. Your DCS-5220 may 
have a different IP Address.
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The window in the center of your browser is the camera image window. You should now see a video image and hear 
the audio over your computer speakers from the DCS-5220. If you are having problems, please consult the Frequently 
Asked Questions section of this manual (page 105).

Open your Internet browser and type in the IP address of the DCS-5220. In this example, the address is: http://192.168.0.120 
(your DCS-5220 may have a different IP address based on what you used in the DCC program).

Testing the DCS-5220
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After all the router settings have been entered correctly, a PC user inside or outside your network will have access to 
the camera through the Internet browser. To access the camera from the Internet, type the IP Address of the router 
given to you by your ISP, followed by a colon, and the port number that you gave your camera (e.g., For example: 
http://70.42.15.9:83). It is not necessary to enter the colon and port number if you are using the default Web server 
port 80. To access from a computer on your local (home) network, simply enter the local IP Address of the Camera 
followed by a colon and the port number (e.g., 192.168.0.120:83).

Viewing Your DCS-5220

If you are following this manual in the order it is presented, you 
should now have an operating DCS-5220 Network Camera 
configured with the Installer program.

• 	Using the DCS-5220 with an Internet browser and 
accessing the screens to control and monitor the camera.
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Open your Internet browser and enter the IP address for your Network Camera (http://192.168.0.120).

In the example, this address is 192.168.0.120. Your address may differ.

If a window appears asking to install a Verisign certificate for authentication click Yes. This allows the proprietary 
MPEG4 video stream to be recognized by Internet browser.

Using the DCS-5220 with an Internet Browser
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Web-based Configuration Utility

To access the configuration utility, open a web-browser such as 
Internet browser and enter the IP address of your Network Camera 
(http://192.168.0.120)

Note: In the example, this address is 192.168.0.120. Your address may differ.

Type Admin in the user name field and leave the password blank 
by default.

Note: You may refer to page 64 to change the password for your 
admin account.

This section will show you how to configure your new D-Link Network Camera using the Web-based Configuration 
Utility.

Click OK
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Live Video
As seen by Mozilla Firefox and Netscape users, Quick Time player is invoked to stream the live video.
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Using RTSP Players

Quick Time Player
Real Player
VLC media player
mpegable Player
pvPlayer

1.	 Launch a RTSP player.
2.	 Choose File > Open URL. 
3.	 Type the URL command in the text box and then click OK. 
	 URL command = rtsp://<ip address of your camera>:<rtsp port>/<access name for stream1 or stream2>

Note: Please refer to pages 44-45 for the RSTP port settings and streaming files.

	
	 For example:

4.	 You can view the live video in your player, as shown in the figure.

Use one of the following media players that support RTSP streaming to view MPEG-4 streaming media. 
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Using 3GPP Mobile Phones
To view streaming media using mobile phones, make sure the Network Camera is setup on the Internet. 

To utilize this feature, please check the Network Settings for your camera.

1.	 Most of the players on 3GPP mobile phones do not support RTSP authentication. Make sure the 
authentication mode of  RTSP streaming is set to Disable. For more information, see page 44.

2.	 The 3G network bandwidth is limited, therefore users cannot use large size videos. Please set the 
video and audio streaming parameters as listed below. For more information, see Audio and Video 
on page 51.

Video Mode MPEG-4

Frame size 176 x 144

Maximum frame rate 5 fps

Intra frame period 1S

Video quality (Constant bit rate) 40kbps

Audio type (GSM-AMR) 12.2kbps

3.	 Set the RTSP port to 554, since most ISPs and players do not support other port numbers.

4.	 Launch the players on 3GPP mobile phones, (ex. Real Player). Type the URL command in the 
player. 

	 URL Command = rtsp://<public ip address of your camera>:<rtsp port>/<access name for stream1/
stream2>
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Camera

Logout: Logout the camera server and close the browser.

Client Settings: Click this button to access the Client Settings.

Snapshot: Capture a still picture of a video.

This section shows your camera’s live video. You can configure the settings using the buttons listed below.

Disable Digital 
Zoom:

Zoom Factors:

Enable/Disable the digital zoom feature. After selecting this 
icon, a small pop-up window will appear (see below).

Select this to disable the digital zoom feature.

Adjust the threshold of the zoom factor. You can also adjust 
and position the zoom area by dragging the box in the 
window.

Click this icon to hide the window. 
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1/2 Digital Zoom - Refer to the previous page for more information.

3/4 Start/Stop Recording - Click (#3) to start recording. Video clips will be recorded in MP4 format to your computer. Press the button again 
(#4) to stop recording. If you close your Internet browser, the video will stop recording.

5/6 Resume/Pause - Click this button (#6) to start or resume the transmission of video streaming. Click the button again (#5), the video will 
pause. 

7 Stop - Click to stop the transmission of video streaming. Click the resume button (#6) to begin streaming.

8 Speaker Volume - When the mute function is not active, move the slider bar to adjust the volume of the speakers that are connected to 
your network camera. 

9/10 Speaker Mute/Unmute - Click (#10) to mute the external speaker that is connected to the network camera. Press again (#9) to unmute 
the speaker.

11 Full screen: To enlarge the video to full screen.

1       2       3       4       5       6       7       8       9     10     11
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Snapshot
This page shows a snapshot image of a live video taken from DCS-5220 network camera.
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Stream 
Options:

Media 
Options:

Protocol 
Options:

UDP 
Protocol:

UDP Unicast:

UDP 
Multicast

TCP:

HTTP 
Protocol:

Record 
Options:

Select which video stream profile to use.

There are 3 selectable Media Options for your stream 
profile. The Default setting is Video and Audio.

There are 4 protocols for you to choose for video 
streaming. 

This is recommended because it is an ideal protocol for 
transmitting real-time audio and video data, which can 
tolerate some lost packets. 

Stream to a single computer. 

Stream to multiple computers using multicast streaming. 

Provides higher quality video streaming than UDP and 
provides error correction. However, transmission speed 
will be reduced. 

Offers the highest image and video quality. However, packet loss will diminish image quality when bandwidth becomes restricted. 
If the network is protected by a firewall and it opens only HTTP port (80), HTTP protocol must be selected. In this mode, audio 
is disabled and only video can be viewed. UDP connections will not be available to remote users if all four ports have not been 
forwarded (as shown on page 41). Only the HTTP port must be forwarded for remote users to make an HTTP connection (video 
only).

Allows the user to specify a destination folder and prefix filename for the recorded video.

Client Setup
Select client settings to access this section.  To configure the settings for media streaming and recording, please read 
the following definitions.
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Setup
Wizard

To quickly configure your network camera, click Internet 
Connection Setup Wizard. Otherwise, click Manual 
Internet Connection Setup to manually configure your 
network camera.

To quickly configure your network camera’s motion 
detection settings, click Motion Detection Setup 
Wizard and skip to page 33. If you want to enter your 
settings without running the wizard, click Manual 
Motion Detection Setup and skip to page 50.

Internet Connection Setup Wizard
This wizard will guide you through a step-by-step process to configure your new D-Link Camera and connect the 
camera to the internet. Click Next to continue.

Click Next
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Click Next

Click Next

Select PPPoE if the camera is directly connected to the 
Internet through a DSL modem and your ISP (Internet 
Service Provider) requires you to use PPPoE for the 
Internet connection. Click Next to continue and skip to 
Step 2 on page 30.

Select DHCP if you are unsure which settings to pick. 
Click Next to continue and skip to page 31.
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Click Next

Click Next

If you have selected PPPoE, enter your username and 
password. Click Next to continue.

Select Static IP if your Internet Service Provider has 
provided you with connection settings, or you wish to set 
a static address within your home network. Enter all the 
relevant LAN information. Click Next to continue. 
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Click Next

Click Next

Click Next

With a Dynamic DNS account, the camera automatically 
updates your IP address. To enable DDNS, enter your 
host information. Click Next to continue.

Enter a name for your camera and click Next to 
continue. 

Configure the correct time to ensure all the events will 
be triggered and scheduled at the correct time.Click 
Next to continue.
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Click Apply

Once you have selected Dynamic, PPPoE, or Static, 
you will see a summary of your camera’s settings. Click 
Apply to save and activate your settings.
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Motion Detection Setup Wizard

This wizard will guide you through a step-by-step process to configure your new D-Link Camera’s motion detection 
functions. Click Next to begin the process. 

Click Next

This screen will allow you to enable or disable the 
motion detection feature. Click New to create and draw 
the motion detection window. Then configure the type 
of recording (snapshot, video clip), Window Name, 
Sensitivity of detection, and Percentage of the window 
required in order to set off motion detection.Click Next 
to continue.

Click Next
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Click Next

Select the recording time and date for your camera. Click  
Next to continue.

Note: Recording camera footage will take up space on your hard 
drive. It is recommended that you have sufficient disk space for 
Always function.

This step allows you to specify your event notification, 
either via email or FTP. Enter the relevant information of 
your email account or FTP settings and then click Next to 
continue.

Click Next



35D-Link DCS-5220 User Manual

Section 3 - Configuration

Click Apply

You have completed the Motion Detection Wizard. Click 
Apply to activate and save your settings.
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LAN Settings:

DHCP:

Static IP Client:

IP Address:

Subnet Mask:

Default Gateway:

Primary DNS:

Secondary DNS:

Enable UPnP 
Presentation:

 

Settings for your local area network.

Select this connection if you have a DHCP server running on your network 
and would like a dynamic IP address to be assigned to your camera 
automatically.

You may enter a static or fixed IP address for your camera. 

Enter an IP address.

The default value is “255.255.255.0.” This helps to determine if the 
designated IP address is on the same subnet.

The gateway used to forward frames to destinations in a different subnet. 
Invalid gateway settings may cause the failure of transmissions to a 
different subnet. Usually the IP address of your router.

Primary domain name server that translates names to IP addresses.

Secondary domain name server to backup the primary one.

Allows a user to find, view, and control this camera via a presentation 
page or “Network Neighborhood” without configuration.

How does UPnP work?

UPnPTM networking technology provides automatic IP configuration and 
dynamic discovery of devices added to a network. Services and capabilities 
offered by networked devices, such as printing and file sharing, are 
available among each other without bothersome network configuration. 
In the case of Network Cameras, you will see Network Camera shortcuts 
at My Network Places.

Network Setup
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Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on the router. You have 
to add the secondary HTTP port number behind the Network Camera’s public address in order to access the Network 
Camera from the Internet. For example, when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, 
refer to the list below for the Network Camera’s IP address.

From the Internet In a local area network

http://203.67.124.123:8080 http://192.168.4.160 or
http://192.168.4.160:8080

If the PPPoE settings are incorrectly configured or the Internet access is not working, restore the Network Camera to 
factory default settings. 



38D-Link DCS-5220 User Manual

Section 3 - Configuration

Enable UPnP Port 
Forwarding:

PPPoE Settings:

HTTP:

Authentication:

HTTP Port:

Secondary HTTP 
Port:

Access name for 
stream1:

Enables the camera to automatically add the port forwarding entry into the router.

Enable this setting if your ISP (DSL service) is using PPPoE. You may already have both Username and Password given 
by your ISP, or you may check with your ISP. The Connect Status will be determined automatically by the system.

You may configure two HTTP ports for your camera. HTTP ports allow you to connect to the camera via a standard 
web browser. These ports can be set to a number other than the default TCP ports 80 and 8080. A corresponding 
port must be opened on the router. For example, if the port is changed to 1010, users must type in the web browser 
“http://192.168.0.100:1010” instead of “http://192.168.0.100”.

Choose either Basic where the password is not encrypted, or Digest where the password is encrypted during the 
transmission to the web server.  

Note: Restart your browser, if you select Digest mode.

Basic authentication:    The password is sent in plain text format; there can be potential risks of being intercepted. 
Digest authentication:  User credentials are encrypted in MD5 algorithm and thus provide better protection against 
unauthorized accesses.

The default value is 80.

The default value is 8080.
After you have enabled the Authentication, you will need to configure and use the access name to access your video file. 
For example, http://camera ip/video.mjpg (video.mjpg is the Access name, you can modify it here)

The default name is video.mjpg.
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Access name for 
stream2:

FTP Port:

RTSP Streaming:

Authentication:

Access name for 
stream1:

Access name for 
stream2:

The default name is video2.mjpg.

Access name for stream 1 / Access name for stream 2 : The access name is used to differentiate the streaming 
source. When using Mozilla Firefox or Netscape to access the Network Camera, and the video mode is set to JPEG, 
users will receive continuous JPEG pictures. This technology, known as "server push", allows the Network Camera to 
feed live pictures to Mozilla Firefox and Netscape. Use the following command to obtain the JPEG file:

	 http://<ip address>:<http port>/<access name for stream1 or stream2>

For example, when the access name for stream 1 is set to video.mjpg:

The URL command is http://192.168.0.051:80/video.mjpg

	 1. Launch Mozilla Firefox or Netscape
	 2. Type the URL command in the address field. Press Enter.
	 3. The JPEG image will be displayed in your web browser.

Default port is 21. If you want to change the port number, you will need to specify the port when connecting to the FTP 
server. For example, FTP://68.5.1.81:60 (if you use port 60 for your FTP server)

This setting enables you to connect to a camera by using streaming mobile device(s), such as a mobile phone or PDA.

Select either Basic where the password is not encrypted, or Digest where the password is encrypted during the transmission 
to the web server. After you have enabled the Authentication, you will need to configure and use the access name to 
access your video file. RTSP://camera ip/live.sdp (live.sdp is the default access name, you can modify in the section 
below)

The default name is live.sdp.

The default name is live2.sdp.
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The accessibility of the RTSP streaming for the three authentication modes are listed in the following table.

Quick Time 
player

Real Player VLC media 
player

mpegable 
Player

pvPlayer

Disable O O O O O

Basic O O X X X

Digest O X X X X

O indicates that the authentication mode is supported by the RTSP player. 
X indicates that the authentication mode is NOT supported by the RTSP player. 

Access name for stream 1 / Access name for stream 2 : The access name is used to differentiate the streaming source. When 
using a RTSP player to access the Network Camera, and the video mode is set to MPEG-4, use the following RTSP URL command 
to request a transmission of streaming data.

rtsp://<ip address>:<rtsp port>/<access name for stream1 or stream2> 

For example, when the access name for stream 1 is set to live.sdp, the URL command is : rstp://192.168.5.121/live.sdp

1 : Launch a RTSP player.
2 : Choose File > Open URL. This opens the URL dialog box.
3 : Type the URL command in the text box. 

For example: 

4 : The live video will be displayed in your player.
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The port number that you use for RSTP streaming, the default port number is 554. RTP (Real Time Protocol) Port is used 
to streaming audio and video while RTCP (Real Time Control Protocol) port is used to monitor QoS of RTP stream.
Note: RTP video port and RTP audio port must be an “even” number. The numbers of RTCP video port and RTCP audio 
port must equal to the numbers of RTP video port and RTP audio port, plus one repetitively.

Default port number is 5556.

Default port number is 5557.

You may choose to enable multicast for your camera audio and video streaming so that your cameras (sources) and the 
receivers (clients) can establish the connection to send and receive contents.

An IP Multicast group address is used to send and receive content. Sources use this group address as the destination 
address while sending their data packets. Receivers use this group address to inform the network that they are interested 
in receiving packets sent to that group. 

RTSP port:

RTP port for video:

RTCP port for 
video:

Multicast group 
address:
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For example, if some content is associated with group 239.1.1.1, the source will send data packets destined to 239.1.1.1. 
Receivers for that content will inform the network that they are interested in receiving data packets sent to the group 
239.1.1.1. The receiver “joins” 239.1.1.1. The Multicast address ranges from 224.0.0.0 to 239.255.255.255, or, equivalently, 
224.0.0.0/4

Default port number is 5560, or please choose between 1024 and 65534.

Default port number is 5561, or please choose between 1024 and 65534.

Default port number is 5563, or please choose between 1024 and 65534.

Set a Time to Live(TTL) value for multicast packet, please choose between 1 and 255.

Multicast video 
port:

Multicast RTCP 
video port:

Multicast RTCP 
audio port:

Multicast TTL 
{1~255]:

Unicast video transmission delivers a stream through point-to-point transmission. On the other hand, multicast video 
transmission sends a stream to the multicast group address and allows multiple clients to acquire the stream by 
requesting a copy from the Multicast group address.

The five ports can be changed between 1025 and 65535. The multicast RTP port must be an even number and the 
multicast RTCP port is equal to multicast RTP port number plus one; thus will always be an odd number. When the 
multicast RTP port changes, the multicast RTCP port needs to be changed accordingly.
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(Service Set Identifier) is a name that identifies a wireless 
network. Access Points and wireless clients attempting to 
connect to a specific WLAN (Wireless Local Area Network) 
must use the same SSID. The default setting is default.

Click on the drop-down list and select from the following options: 
Infrastructure - connecting the WLAN using an Access Point 
such as the DWL-2100AP or a DIR-655 wireless router. 
Ad-Hoc – wireless mode used when connecting directly to 
a computer equipped with a wireless Adapter in a peer-to-
peer environment. 

In Infrastructure mode, the wireless channel is automatically 
selected by the camera. In Ad-Hoc mode, the default wireless 
channel setting is channel 6. Select the channel that is the 
same as the other wireless devices on your network.

Select the transmission rate on the network. Auto is the 
default setting.

Select the encryption type from the drop-down list. The default 
setting for encryption is None, which means the security  
is disabled.

Wireless Setup

SSID:

Wireless Mode:

Channel:

TX Rate:

Security:
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If the encryption type selected is WEP from the Security drop-down list, choose one of the authorization modes:
Open - communicates the key across the network.
Shared – allows communication only with other devices with identical WEP settings.

Select the key length, either 64 bits or 128 bits.

Select an ASCII or HEX (hexadecimal) key format.

You can create up to 4 different security keys.

The Key allows the camera to connect to other devices by using WPA-PSK encryption. Pre-shared key must be 8-63 
characters or 64 hex characters.

Auth mode:

Key length:

Key format:

Key index:

Pre-shared key:
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Enable DDNS:

Server Name:

Host Name:

Username:

Password:

Status:

Click to enable the DDNS function.

Select your Dynamic DNS provider from the drop 
down menu.

Enter the host name of the DDNS server.

Enter your username or e-mail used to connect 
to the DDNS server.

Enter your password used to connect to the DDNS 
server.

Indicates the current connection status.

Dynamic DNS
DDNS (Dynamic Domain Name Server) will hold a DNS host name and synchronize the public IP address of the modem 
when it has been modified. The username and password are required when using the DDNS service.
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Image Setup
You may configure the image settings of the video for your network camera. A preview of the image will be shown in 
the window of Live Video. Click Save Settings to save and activate your changes.

Color:

Power Line 
Frequency:

Video Orientation:

White Balance:

Brightness:

Select either a Color or B/W (black and white, 
monochrome) video display.

Select either 50 or 60Hz. 

Flip will vertically rotate the video. Mirror will 
horizontally rotate the video. You may check 
both options if the camera is being installed 
upside down.

Select either Auto or Fix from the drop-down 
box. Select Auto to automatically adjust the 
white balance of the object. Otherwise, select 
Fix to manually set the white balance conditions 
in advance.

Select to change the brightness value for the 
Network Camera. The range varies from -5  
to +5.
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Saturation: 

Sharpness: 

Overlay Title and 
Time Stamp on 

Video:

Allow 
unauthenticated 

snapshots:

Select to change the saturation value of the camera. The default value is 0.

Select to change the Sharpness value of the camera. The default value is 0.

Select to add a date and time stamp on the video. 

Select to allow user to get snapshot without authentication via web CGI command.
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Mode:

Frame Size:

Maximum 
frame rate:

Video quality:

Mute:

Select either JPEG or MPEG4. In JPEG mode, 
the video frames are independent. However, 
MPEG4 consumes much less network bandwidth 
than JPEG.

Select 176 x 144, 352 x 240 or 640 x 480 pixels 
for the frame size. We recommend 176 x 144 
for mobile viewing and 640 x 480 for a computer 
monitor.

The minimum frame rate value is 1fps and the 
maximum is 30fps. We recommend 30fps for 
computer monitors and 5fps for mobile viewing.

This setting limits the maximum refresh frame rate. 
To set a fixed bandwidth regardless of the video 
quality, select Constant bit rate and the desired 
bandwidth. Select Fixed Quality to optimize the 
bandwidth utilization and video quality. 

Select to mute audio.

Audio and Video
Settings for two video streams (stream 1 and stream 2) can be configured here. You may configure one setting for 
computer display and the other one for mobile display.
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Advanced Audio Coding (AAC) is a wide band audio coding algorithm that exploits two primary coding strategies to 
dramatically reduce the amount of data needed to convey high-quality digital audio. Select a higher bit rate number for 
better audio quality.

Select an AAC bit rate from the drop-down list. Higher bit rate means higher audio quality but it takes more network 
bandwidth to transmit.

A standard adaPTZd audio codec by the 3GPP video (3rd Generation Partnership Project).  It is an Adaptive Multi Rate-
Narrow Band (AMRNB) speech codec. Select a higher bit rate number for better audio quality.

Select the GSM-AMR bit rate from the drop-down list. Higher bit rate means higher audio quality but it takes more network 
bandwidth to transmit.

Audio type:

AAC bit rate:

GSM-AMR:

GSM-AMR
bit rate:
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Enable motion 
detection:

Window name:

Sensitivity:

Percentage:

New:

Save:

Check this option to turn on the motion detection 
feature.

Create your own name for the monitored area/ 
window. It will show at the top of the motion 
window.

Set the measurable difference between two 
sequential images that would indicate motion.

Set the amount of motion in the window being 
monitored that is required to initiate a motion 
detected alert. If this is set to 100%, this means that 
motion must be detected within the whole window 
to trigger a snapshot. 

Note: Setting a higher sensitivity and a lower 
percentage will make motion easier to be 
detected. 

Click to add a new window. A maximum of three 
motion windows can be opened simultaneously. 
Use your mouse to drag the window frame to re-
size or the title bar to move. Clicking on the ‘x’ at 
the upper right corner of the window will close the 
window.

Save the related settings of that window.

Motion Detection
Once Motion Detection feature is enabled, users will be able to monitor three windows with different settings. This 
allows your camera to serve as a security device that records only when motion is detected.
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1.	Click New to add a new motion detection window.
2.	Enter a name in the Window Name field. 
3.	Define the sensitivity to moving objects and the space ratio of all alerted pixels by moving the Sensitivity and 

Percentage slide bar.
4.	Click Save to apply the changes.
5.	Select Enable motion detection to activate motion detection.

Note: Drag to resize the window and click X to close the window.

The Percentage Indicator will rise or fall depending on the image variation. When motions are detected by the Network 
Camera and are judged to exceed the defined threshold, a red bar rises. Meanwhile, the motion detection window will 
be outlined in red. Utilizing this device as a trigger source, photos or videos can be captured instantly and sent to the 
remote server (Email, FTP).
 
A green bar indicates that even though motions are detected, the event will not be triggered because the image variations 
are still falling under the defined threshold.

Percentage = 30% 

To enable motion detection, follow the steps below:
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How does motion detection work?

There are two parameters for setting the motion detection: Sensitivity and Percentage. In the illustration above, frame 
A and frame B are two sequential images. Pixel differences between the two frames are detected and highlighted in 
gray (frame C), and will be compared with the sensitivity setting. Sensitivity is a value that expresses the sensitivity to 
moving objects. Higher sensitivity settings are expected to sense a slight movement while smaller sensitivity settings 
tend to neglect it. When the sensitivity is set to 70%, the Network Camera defines the pixels in the purple areas as 
“alerted pixels” (frame D). Percentage is a value that expresses the proportion of “alerted pixels” to all pixels in the 
motion detection window. In this case, 50% of pixels are identified as “alerted pixels”. When the percentage is set to 
30%, the motions are judged to exceed the defined threshold; therefore, the motion window will be outlined in red.

For applications that require higher security management, it is suggested to set higher sensitivity settings and smaller 
percentage values.

A

B D

C
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Current Server Time:

Time Zone:

Enable Daylight 
Saving:

Daylight Saving 
Dates:

Automatic Time 
Configuration:

NTP Server:

Update Interval:

Set the date and 
time manually:

Copy Your 
Computer’s Time 

Settings:

Displays current time.

Select your time zone from the drop-down menu.

Select this to enable the daylight saving time 
(DST). During DST, the system clock moves one 
hour ahead.

Note: To utilize this feature, ensure to set the time 
zone of your network camera. Then starting and 
ending time of the DST is displayed upon selecting 
the option.

You may configure the daylight saving date and 
time.

Enable this feature to obtain time configuration 
automatically from NTP server.

Network Time Protocol (NTP) synchronizes the 
DCS-5220 with an Internet time server. Choose 
the one that is closest to your location.

The time interval for updating the time information 
from NTP server.

This option allows you to set the time and date manually.

This will synchronize the time information from your PC.

Time and Date
Automatically or manually configure, update, and maintain the internal system clock for your camera.
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Event Setup
There are four sections in Event Setup page. 

• Event
• Server 
• Media
• Recording

1. To add a new item - event, server or media, click 
Add. A pop-up will appear and update the fields 
accordingly.

2. To delete the selected item from the pull-down menu 
of event, server or media, click Delete. 

3. Click on the item name for further modification.

Note: You can add up to four events, five servers and five media 
fields.
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Application

A typical application is that when motion is detected, the DCS-5220 Network Camera sends images to a FTP server or 
via e-mail as notifications. For example, as seen in the illustration below, an event can be triggered by many sources, 
such as motion detection or external digital input devices. When an event is triggered, you can specify what kind of 
action will be performed. You can configure the Network Camera to send snapshots or videos to your email address 
or FTP site.

To start plotting an event, it is suggested to configure server and media columns first so that the Network Camera will 
know what action shall be performed when a trigger is activated.

ex. 
Motion detection, 
Periodically, Digital input, 
System reboot

Event Condition

ex. 
Snapshot, Video Clips

ex. 
Email, FTP

Media
(what to send)

Server
(where to send)

Action
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Server Name:

Email:

FTP:

HTTP:

Network Storage:

Unique name of your server.

Select this to enable and apply your email account 
setting for your camera.

Select this to access a granted folder on the 
external FTP server.

Select this to use a web server to store the 
media.

Only one network storage device is supported.

Add Server

You may configure up to 5 servers for media storage. 
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Media Name:

Snapshot:

Source:

Send pre-event 
image(s) [0~7]:

Send post-event 
image(s) [0~7]:

File name prefix:

Add date and time 
suffix to file name:

Video clip:

Source:

Pre-event recording:

Maximum duration:

Maximum file size:

File name prefix:

System log:

Enter an unique name for media.

Select this feature to enable camera to take 
snapshot.

The source of stream: stream1 or stream2.

The number of pre-event images.

The number of post-event images. Refer page 61 
for more information.

The prefix name will be added on the file name.

Check it to add timing information as file name 
suffix. Refer page 61 for more information.

Select this feature to enable camera to take video 
clip.

The source of stream: stream1 or stream2.

The interval of pre-event recording in seconds.

The maximal recording file duration in seconds. Refer page 62 for more information.

The maximal file size would be generated. 

The prefix name will be added on the file name of the video clip. Refer page 62 for more  information.

Select this feature to enable camera to display system log.

Add Media

There are three types of media-Snapshot, Video Clip and System Log.
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Send post-event image (s) [0~7)
Specify to capture the number of images after a trigger is activated. A maximum of seven images can be generated.

For example:
If both the Send pre-event images and Send post-event images are set to seven, a total of 15 images are generated 
after a trigger is activated.

Add date and time suffix to file name
Select this option to add date and time to the file name suffix.

1 pic. 2 pic. 3 pic. 4 pic. 5 pic. 6 pic. 7 pic. 8 pic. 9 pic. 10 pic. 11 pic. 10 pic. 12 pic. 13 pic. 14 pic. 15 pic.

The moment the 
trigger is activated.

SNAPSHOTS20080104_100341

Date and time suffix
The format is: YYYYMMDD_HHMMSS

File name prefix
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Maximum duration
Specify the maximal recording duration in seconds. You can set up to ten seconds.

For example:
If the Pre-event recording is set to five seconds and the Maximum duration is set to ten seconds, the Network Camera 
continues to record for another four seconds after a trigger is activated.

File name prefix
Enter the text that will be added at the beginning of the file name.

1 sec. 2 sec. 3 sec. 4 sec. 5 sec. 6 sec. 7 sec. 8 sec. 9 sec. 10 sec.

The moment the 
trigger is activated.

VIDEOS20080104_100341

Date and time suffix
The format is: YYYYMMDD_HHMMSS

File name prefix
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Event name:

Enable this 
event:

Priority:

Delay:

Trigger:

Video motion 
detection:

Periodic:

System boot:

Time:

Move to preset 
location:

Enter a name for the event.

Select to activate this event.

Set the priority for this event. The event with 
higher priority will be executed first.

Select the delay time before checking next 
event. It is being used for both events of motion 
detection and digital input trigger.

The input type that triggers the event.

Motion is detected during live video monitoring. 
Select the windows that need to be monitored.

The event is triggered in specified intervals. The 
unit of trigger interval is minute.

Triggers an event when the system boots up. 

Select Always or enter the time interval.

Select to move camera PTZ to the preset 
position.

Add Event
Create and schedule up to 3 events with their own settings here. 
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Recording entry 
name:

Enable this 
recording:

Priority:

Source:

Recording 
schedule:

Recording 
settings:

Destination:

Total cycling 
recording size

Size of each file 
for recording:

File Name 
Prefix:

The unique name of the entry.

Select this to enable the recording function.

Set the priority for this entry. The entry with a higher 
priority value will be executed first.

The source of stream.

Scheduling the recording entry.

Configuring the setting for the recording.

Select the folder where will store the recording 
file.

Please input a HDD volume between 1MB and 
200GB for recording space. The recording data will 
replace the oldest one when total recording size exceeds this value. For example, if each recording file is 6MB, and the total 
cycling recording size is 600MB, then the camera will record 100 files to the specified location (folder) and then will delete 
the oldest file and create new file for cycling recording.
Please note that if the HDD empty space is not enough, the recording will stop. Before you setup this option please make 
sure your HDD has enough space and it is better to not save other files in the same folder as recording files. 

File size for each recording file. You may input the value in the range of 200-6000.

The prefix name will be added on the file name of the recording file(s).

Add Recording
Here you can configure and schedule the recording settings.
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“Home” aims the camera to the center and the 
other buttons aim the camera accordingly. 

Select the speed at which the camera will pan for 
a full cycle from the drop-down list. Select a value 
between -5 and +5, -5 being the slowest setting.

Select the speed at which the camera will tilt for a 
full cycle from the pull down menu. Select a value 
between -5 and +5, -5 being the slowest setting.

Select the speed at which the camera will pan 
during auto patrol. Select a value between 1 and 
5, 1 being the slowest setting.

Enter a name for the position at which you would 
like to preset the DCS-5220. Click Add to add the 
new preset position to the Preset Locations list.

Using the drop-down list, you can delete a preset 
position by selecting it and clicking Delete.

Use the Save as home button to set the current position as the home position. The Home position is the 
first position the camera goes to after the camera boots. You can also recall the default home position, use 
the Default home button.

To use the Auto Patrol feature, select the desired preset positions from the Preset Locations list and add 
them to the Selected Locations list by clicking Select. You can then select the order in which the camera 
will patrol through the preset locations by selecting a location and clicking UP or DN. Click Remove to 
remove a location from the list.

Click the Camera Control button from the left side of the Setup screen to access settings that affect how the DCS-
5220 Network Camera can pan and move to preset locations.

Camera Control

Left, Up, Right, Down, 
& Home:

Pan Speed:

Tilt Speed:

Auto Pan/ 
Patrol Speed:

Current Position:

Preset Position:

Home definition:

Patrol Selection:
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The starting IP Address of the devices 
(such as a computer) that have 
permission to access the video of the 
camera.

The ending IP Address of the devices 
(such as a computer) that have 
permission to access the video of the 
camera.

Remove the customized setting from 
the Allow List.

The starting IP Address of the devices 
(such as a computer) that don’t have 
permission to access the video of the 
camera.

The ending IP Address of the devices (such as a computer) that don’t have permission to access the 
video of the camera.

Remove the customized setting from the Deny List.

Click the Access List button from the left side of the Setup screen to access Access List settings.

Access List

Allow List Start IP Address:

Allow List End IP Address:

Delete Allow List:

Deny List Start IP Address:

Deny List End IP Address:

Delete Deny List:
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Maintenance
Admin

Admin password 
setup:

Add user 
account:

Username:

Password:

Privilege:

Allow PTZ 
control:

Manage user:

Authentication:

Camera Name:

Modify the password for the administrator’s 
account.

Add a new user account.

Enter a username for the new account.

Enter a password for the new account.

Select the access rights for the new user.

Select to allow guest account to control PTZ 
function.

Manage the accounts for existing users.

The access rights for existing users.

Create a unique name for your camera and you 
can access the camera using this name in your 
web-browser. For example: http://DCS-5220  
(by default).

You can modify both the camera’s name and the administrator’s password, as well as add more user accounts for 
accessing the camera.
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Turn off the 
LED indicator:

Restore:

Save 
configuration:

Restore 
configuration:

Reboot:

Select this option to turn off the LED next to the 
lens. This will prevent anyone from observing the 
operation of the network camera.

Click the Restore button to reset the camera back 
to its factory default settings. This will remove all the 
configuration settings that were previously made.

Click to save the camera’s configuration file to your 
computer for restoration purpose.

You may browse and load the configuration file, 
then click Load Configuration to restore the pre-
configurated or saved settings.

Click the Reboot button to restart the camera.

SYSTEM
The Backup and Restore page will allow you to turn the front panel LED off, restore factory default settings, and reboot 
the camera.
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Current firmware 
version:

Current firmware 
date:

File Path:

Upload:

It will be automatically determined and displayed 
by the system.

It will be automatically determined and displayed 
by the system.

Locate the file (upgraded firmware) on your hard 
drive using the browse feature.

Start uploading and upgrading the new firmware 
to your camera.

Firmware Update
Your current firmware version and date will be displayed on your screen. You may go to the D-Link Support page to 
check for the latest firmware version available. 

To upgrade the firmware on your DCS-5220, please download and save the latest firmware version from the D-Link 
support site to your local hard drive. Locate the file on your local hard drive by clicking the Browse button. Then, open 
the file and click the “Upload” button to start the firmware upgrade.
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Status
Device Info

This page displays all the details information about your device and network connection.
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Enable remote log:

Log server settings:

IP Address:

Port:

Save:

Current Log:

Click to enable this feature so that the 
camera can send camera log files to a 
remote server.

Configure the settings for the log server.

The IP address of the remote server.

The port number of the remote log server. 
The default port is 514.

Click to save the settings.

Displays the the system’s log file. The 
content of the file reveals useful information 
about camera configuration and connectivity 
status after the camera boots up.

Logs
This page displays the log information of your camera. You can configure a remote log server so that you can view 
your log details remotely.
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Help
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Wireless Security
This section will show you the different levels of security you can use to protect your data from intruders. The DCS-
5220 offers the following types of security:

• WPA-PSK (Pre-Shared Key)
• WEP (Wired Equivalent Privacy)

What is WEP?
WEP stands for Wired Equivalent Privacy. It is based on the IEEE 802.11 standard and uses the RC4 encryption 
algorithm. WEP provides security by encrypting data over your wireless network so that it is protected as it is transmitted 
from one wireless device to another.

To gain access to a WEP network, you must know the key. The key is a string of characters that you create. When 
using WEP, you must determine the level of encryption. The type of encryption determines the key length. 128-bit 
encryption requires a longer key than 64-bit encryption. Keys are defined by entering in a string in HEX (hexadecimal - 
using characters 0-9, A-F) or ASCII (American Standard Code for Information Interchange – alphanumeric characters) 
format. ASCII format is provided so you can enter a string that is easier to remember. The ASCII string is converted to 
HEX for use over the network. Four keys can be defined so that you can change keys easily.
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What is WPA?
WPA, or Wi-Fi Protected Access, is a Wi-Fi standard that was designed to improve the security features of WEP (Wired 
Equivalent Privacy).  

The 2 major improvements over WEP: 

• Improved data encryption through the Temporal Key Integrity Protocol (TKIP). TKIP scrambles the keys 
using a hashing algorithm and, by adding an integrity-checking feature, ensures that the keys haven’t been 
tampered with. WPA2 is based on 802.11i and uses Advanced Encryption Standard instead of TKIP.

• User authentication, which is generally missing in WEP, through the extensible authentication protocol 
(EAP). WEP regulates access to a wireless network based on a computer’s hardware-specific MAC 
address, which is relatively simple to be sniffed out and stolen. EAP is built on a more secure public-key 
encryption system to ensure that only authorized network users can access the network.

WPA-PSK/WPA2-PSK uses a passphrase or key to authenticate your wireless connection. The key is an alpha-numeric 
password between 8 and 63 characters long. The password can include symbols (!?*&_) and spaces. This key must 
be the exact same key entered on your wireless router or access point.



72D-Link DCS-5220 User Manual

Appendix D - Frequently Asked Questions

To ensure the highest security and prevent unauthorized 
use of the Network Camera, the Administrator has the 
exclusive privilege to access the System Administration 
settings to allow users entry and authorize privileges 
for all users. The Network Camera supports multi-level 
password protection/access to the Network Camera 
that can be restricted to defined users who have a User 
Name and User Password, which is assigned by the 
Administrator. 

The Administrator can release a public user name and 
password so that when remote users access the Network 
Camera they will have the right to view the image 
transmitted by the Network Camera.

When the Network Camera is used for the first time, it is 
highly recommended that the Administrator set the Administrator’s Password to constrain user access to the Network 
Camera since the Default settings are Null String (no password). Once the Password is defined, only the Administrator 
has access to the management of the  Network Camera. This procedure should be done as soon as possible since 
the security features of the Network Camera will not be enabled until the Administrator Password is defined.

At this point it is highly recommended that you click on 
the Maintenance button on the Home screen, and then 
the Tools tab to bring you to the Admin screen. Enter a 
password for security purposes. 

Setting Security
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D-Link’s DCS-5220 is a versatile and cost effective Network Camera offering both video and audio monitoring. It can 
also serve as a powerful surveillance system in security applications. The DCS-5220 can be used with any wired or 
802.11b/g wireless router. This section explains how to view the camera from either the Internet or from inside your 
internal network.

Materials Needed: 

		  • 1 DCS-5220 Network Camera

• 1 Ethernet Cable 

• A Wired or Wireless router such as the D-Link DIR-655 Wireless Router

• Ethernet based PC for system configuration

Setting up the DCS-5220 for Use Behind a Router
Installing a DCS-5220 Network Camera on your network is an easy 4–step procedure:

1	 Assign a Local IP Address to Your Network Camera

2	 View the Network Camera Using Your Internet Browser

3	 Access the Router with Your Web Browser

4	 Open Virtual Server Ports to Enable Remote Image Viewing

This section is designed to walk you through the setup process for installing your camera behind a router and enable 
remote video viewing. For the basic setup of the DCS-5220, follow the steps outlined in the Quick Installation Guide.

Using & Configuring the DCS-5220 with a NAT Router
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Run the DCC program from the CD included with the DCS-5220. Follow the steps in the Quick Installation Guide to 
configure the DCS-5220. The camera will be assigned a local IP Address that allows it to be recognized by the router. 
Write down this IP Address for future reference.

1	 Assign a Local IP Address to Your Camera 

After you have completed the setup of the DCS-5220 outlined in the Quick Installation Guide you will have an operating 
camera that has an assigned IP Address. Because you are using a router to share the Internet with one or more PCs, 
the IP Address assigned to the Network Camera will be a local IP Address. This allows viewing within your Local Area 
Network (LAN) until the router is configured to allow remote viewing of the camera over the Internet.

This is the IP Address assigned to your camera. Write it down for later use. 172.17.5.108 is only an example. You will 
probably have a different IP Address.
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Run your Internet browser. In the address bar, type in the IP Address that was assigned to the Network Camera by 
the DCC program. The DCS-5220 Live Video Page appears with a window displaying live video from the camera. You 
are able to view this screen from any PC running Internet browser on your LAN.

Click on the Setup button on the left side of the display. Scroll to the bottom of the Network Setup page (see page 36) 
to display the ports used by HTTP and Streaming audio and video.

2	 View the Network Camera Using Your Internet Browser
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The Setup > Network Setup page displays the port settings for your camera. If necessary, these ports can be 
changed if they are already in use by other devices (e.g. in a multiple camera environment).

Note: Ports 5556 - 5559, and both HTTP port and RTSP port 
are required to be opened for the DCS-5220. Please refer to 
page 86 on how to open ports in the router.
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The following steps generally apply to any router that you have on your network. The D-Link DIR-655 is used as an 
example to clarify the configuration process. Configure the initial settings of the DIR-655 by following the steps outlined 
in the DIR-655 Quick Installation Guide.

3	 Access the Router with Your Web Browser

If you have cable or DSL Internet service, you will most likely have a 
dynamically assigned WAN IP Address. ‘Dynamic’ means that your router’s 
WAN IP address can change from time to time depending on your ISP.  A 
dynamic WAN IP Address identifies your router on the public network and 
allows it to access the Internet.  To find out what your router’s WAN IP Address 
is, go to the Status menu on your router and locate the WAN information for 
your router (as shown on the next page). The WAN IP Address will be listed. 
This will be the address that you will need to type in your Web browser to 
view your camera over the Internet. 

Router Set-Up and Installation

Your WAN IP Address will be listed on the router’s 
Status > Device Info page.
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Note: Because a dynamic WAN IP can change from time to time depending on your ISP, you may want to obtain a 
Static IP address from your ISP. A Static IP address is a fixed IP address that will not change over time and will be more 
convenient for you to use to access your camera from a remote location. The Static IP Address will also allow you to 
access your camera attached to your router over the Internet.

4	 Open Virtual Server Ports to Enable Remote Image Viewing

The firewall security features built into the DIR-655 router prevent users from accessing the video from the DCS-5220 
over the Internet. The router connects to the Internet over a series of numbered ports. The ports normally used by the 
DCS-5220 are blocked from access over the Internet. Therefore, these ports need to be made accessible over the 
Internet. This is accomplished using the Virtual Server function on the DIR-655 router. The Virtual Server ports used 
by the camera must be opened through the router for remote access to your camera. Virtual Server is accessed by 
clicking on the Advanced tab of the router screen.

1	 Click Enabled.

2	 Enter a different name for each entry.

3	 Enter your camera’s local IP Address (e.g., 192.168.0.120 in the example in step 2 on page 87) in the 
Private IP field.

4	 Select TCP for HTTP port, both (TCP and UDP) for RTSP and both (TCP and UDP) for 5556 - 5559 
ports.

5	 If you are using the default camera port settings, enter 80 into the Public and Private Port section, click Apply.

6	 Scheduling should be set to Always so that the camera images can be accessed at any time.

Follow these steps to configure your router’s Virtual Server settings:
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Repeat the above steps adding the port 554 to both the Public and Private Port sections. A check mark appearing 
before the entry name will indicate that the ports are enabled.

Important: Some ISPs block access to port 80 and other commonly used Internet ports to conserve bandwidth. Check 
with your ISP so that you can open the appropriate ports accordingly. If your ISP does not pass traffic on port 80, you 
will need to change the port the camera uses from 80 to something else, such as 800. Not all routers are the same, so 
refer to your user manual for specific instructions on how to open ports.

Enter valid ports in the Virtual Server section of your router. Please make sure to check the box next to the camera 
name on the Virtual Server List to enable your settings.
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Before you start, please refer to page 39 to find the Access Name of the RTSP protocol. To enter the RTSP streaming 
address, please follow this format: rtsp://ip address of the camera/live.sdp.

To enable mobile device video streaming, you will need 
to select Configure for mobile viewing (see sample 
screenshot to the right).

Using & Configuring 3G Compatible Cell Phones
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The following steps are based on a Nokia 6630 cell phone. 

Play from RealPlayer

Press the Menu button and select Media

Select Open

Select RealPlayer
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Select Open

When RealPlayer opens, press Options
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Select Download

Select Video Clips

Press Options

Note: 71.34.50.5 is the camera’s IP address in this sample.



84D-Link DCS-5220 User Manual

Appendix D - Frequently Asked Questions

Select Navigation Options

Select Go to web address

Input your rtsp address
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Press Yes, and allow Connection and 
Loading of the streaming video.

Enjoy streaming video on your cellphone.
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Play from PVPlayer

Press the Menu button and select PVPlayer

Select Open

Press the Options button
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Select Open location

Input your rtsp address

Note: 71.34.50.5 is the camera’s IP address in this sample.
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Enjoy streaming video on your cellphone.
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D-Link wireless products are based on industry standards to provide easy-to-use and compatible high-speed wireless 
connectivity within your home, business or public access wireless networks. Strictly adhering to the IEEE standard, 
the D-Link wireless family of products will allow you to securely access the data you want, when and where you want 
it. You will be able to enjoy the freedom that wireless networking delivers.

A wireless local area network (WLAN) is a cellular computer network that transmits and receives data with radio signals 
instead of wires. Wireless LANs are used increasingly in both home and office environments, and public areas such 
as airports, coffee shops and universities. Innovative ways to utilize WLAN technology are helping people to work and 
communicate more efficiently. Increased mobility and the absence of cabling and other fixed infrastructure have proven 
to be beneficial for many users. 

Under many circumstances, it may be desirable for mobile network devices to link to a conventional Ethernet LAN in 
order to use servers, printers or an Internet connection supplied through the wired LAN.  A Wireless Router is a device 
used to provide this link.

Wireless Basics
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What is Wireless?

Wireless or WiFi technology is another way of connecting your computer to the network without using wires. WiFi uses 
radio frequency to connect wirelessly, so you have the freedom to connect computers anywhere in your home or office 
network.

Why D-Link Wireless? 
  
D-Link is the worldwide leader and award winning designer, developer, and manufacturer of networking products. 
D-Link delivers the performance you need at a price you can afford. D-Link has all the products you need to build your 
network.

How does wireless work? 
  
Wireless works similar to how cordless phone work, through radio signals to transmit data from one point A to point 
B. But wireless technology has restrictions as to how you can access the network. You must be within the wireless 
network range area to be able to connect your computer. There are two different types of wireless networks Wireless 
Local Area Network (WLAN), and Wireless Personal Area Network (WPAN).

Wireless Local Area Network (WLAN)

In a wireless local area network, a device called an Access Point (AP) connects computers to the network. The access 
point has a small antenna attached to it, which allows it to transmit data back and forth over radio signals. With an 
indoor access point as seen in the picture, the signal can travel up to 300 feet. With an outdoor access point the signal 
can reach out up to 30 miles to serve places like manufacturing plants, industrial locations, college and high school 
campuses, airports, golf courses, and many other outdoor venues.
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Who uses wireless? 
  
Wireless technology as become so popular in recent years that almost everyone is using it, whether it’s for home, 
office, business, D-Link has a wireless solution for it.

Home
	 • Gives everyone at home broadband access
	 • Surf the web, check email, instant message, and etc
	 • Gets rid of the cables around the house
	 • Simple and easy to use
 

Small Office and Home Office
	 • Stay on top of everything at home as you would at office
	 • Remotely access your office network from home
	 • Share Internet connection and printer with multiple computers
	 • No need to dedicate office space
 
 

 

Where is wireless used? 
  
Wireless technology is expanding everywhere not just at home or office. People like the freedom of mobility and it’s 
becoming so popular that more and more public facilities now provide wireless access to attract people. The wireless 
connection in public places is usually called “hotspots”.
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Using a D-Link Cardbus Adapter with your laptop, you can access the hotspot to connect to Internet from remote 
locations like: Airports, Hotels, Coffee Shops, Libraries, Restaurants, and Convention Centers.

Wireless network is easy to setup, but if you’re installing it for the first time it could be quite a task not knowing where to 
start. That’s why we’ve put together a few setup steps and tips to help you through the process of setting up a wireless 
network.

Tips

Here are a few things to keep in mind, when you install a wireless network.

Centralize your router or Access Point
  
Make sure you place the router/access point in a centralized location within your network for the best performance. Try 
to place the router/access point as high as possible in the room, so the signal gets dispersed throughout your home. 
If you have a two-story home, you may need a repeater to boost the signal to extend the range.

Eliminate Interference 
  
Place home appliances such as cordless telephones, microwaves, and televisions as away as possible from the router/
access point. This would significantly reduce any interfere that the appliances might cause since they operate on same 
frequency.

Security 
  
Don’t let you next-door neighbors or intruders connect to your wireless network. Secure your wireless network by 
turning on the WPA or WEP security feature on the router. 
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There are basically two modes of networking: 

•	Infrastructure – All wireless clients will connect to an access point or wireless router.

•	Ad-Hoc – Directly connecting to another computer, for peer-to-peer communication, using wireless network 
adapters on each computer, such as two or more DCS-5220 wireless network Cardbus adapters.

An Infrastructure network contains an Access Point or wireless router. All the wireless devices, or clients, will connect 
to the wireless router or access point. 

An Ad-Hoc network contains only clients, such as laptops with wireless cardbus adapters. All the adapters must be in 
Ad-Hoc mode to communicate.

Wireless Modes
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Networking Basics

Check your IP address
After you install your new D-Link adapter, by default, the TCP/IP settings should be set to obtain an IP address from 
a DHCP server (i.e. wireless router) automatically. To verify your IP address, please follow the steps below.

Click on Start > Run. In the run box type cmd and click OK. (Windows Vista® users type cmd in the Start Search 
box.)

At the prompt, type ipconfig and press Enter.

This will display the IP address, subnet mask, and 
the default gateway of your adapter.

If the address is 0.0.0.0, check your adapter 
installation, security settings, and the settings 
on your access point. Some firewall software 
programs may block a DHCP request on newly 
installed adapters. 

If you are connecting to a wireless network at a hotspot (e.g. hotel, coffee shop, airport), please contact an employee 
or administrator to verify their wireless network settings.
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Statically Assign an IP address
If you are not using a DHCP capable gateway/access point, or you need to assign a static IP address, please follow 
the steps below:

Step 1
Windows Vista® -	 Click on Start > Control Panel > Network and Internet > Network and Sharing Center > Manage 

Network Connections.
Windows® XP - Click on Start > Control Panel > Network Connections.

Step 2
Right-click on the Local Area Connection which represents your D-Link network adapter and select Properties.

Step 3
Highlight Internet Protocol (TCP/IP) and click Properties.

Step 4
Click Use the following IP address and enter an IP address that is on the same 
subnet as your network or the LAN IP address on your access point. 

Example: If the network camera’s LAN IP address is 192.168.0.1, make your IP 
address 192.168.0.X where X is a number between 2 and 99. Make sure that the 
number you choose is not in use on the network. Set Default Gateway the same 
as the LAN IP address of your access point (192.168.0.1). 

Set Primary DNS the same as the LAN IP address of your access point 
(192.168.0.1). The Secondary DNS is not needed or you may enter a DNS server 
from your ISP.

Step 5
Click OK to save your settings.
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Reset and Restore

Restoring the factory defaults will result in 
the loss of any previous settings and will 
require running the Installation Wizard to 
return the DCS-5220 to a normal state.

Reset button

The hidden button in the pinhole beside the Ethernet socket is used to reset the system or restore the factory default 
settings. Sometimes resetting the DCS-5220 will return the system back to a normal state. If the system still has 
problems after reset, restore the factory settings and install again:

RESET: 
1.	Lightly insert a paper clip (or a similar sized tool) into the reset 

hole on the back of the camera, press lightly and then release the 
button.

2.	The LED on the front of the camera will begin blinking red and 
green.

3.	When the LED stops the blinking the reset has completed. 

RESTORE:
1.	 Insert the paperclip or other tool and hold the button in.

2.	Wait for the LED on the front of the camera to blink red and green 
and hold the button for 30 seconds.

3.	Withdraw the tool after the second cycle of the LED blinking and 
a factory restore has been completed.
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Frequently Asked Questions

Wireless PTZ Network Camera Features
1. What is a Wireless PTZ Network Camera ?
The Wireless PTZ Network Camera is a stand-alone system connecting directly to an Ethernet or Fast Ethernet network. The Wireless 
PTZ Network Camera differs from a conventional PC Camera because it has an integrated system with built-in CPU and web-based 
solutions, providing a low cost solution that can transmit high quality video images for monitoring. The Wireless PTZ Network Camera can 
be remotely managed, accessed and controlled using a web browser from any computer over an Intranet or Internet.

2. What is the maximum number of users that can access DCS-5220 simultaneously?
The maximum number of users that can log onto the Wireless PTZ Network Camera at the same time is 10. Please keep in mind the 
overall performance of the transmission speed will be reduced if many users have logged on to the camera simultaneously.

There is no limit on the number of users when a multicast-enabled router is being used. The multicast protocol helps reduce the network 
bandwidth consumption.
Note that the Network Camera must be configured to enable multicast streaming. For more information, see RTSP Streaming on page 
41.

3. What algorithm is used to compress the digital image?
The Wireless PTZ Network Camera utilizes MPEG-4 simple profile or MJPEG Mode image compression technology providing high quality 
images. MJPEG is a standard for image compression and it can be applied to various web browsers and application software without 
installing any extra software

4. Can I capture still images from the Wireless PTZ Network Camera?
Yes, you can capture still images using the snapshot function.

This chapter provides solutions to problems that may occur during the installation and operation of the DCS-5220. 
Read the following descriptions if you are having any problems. 
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Fixed Dome Day & Night Network Camera Installation
1. Can the Network Camera be used outdoors?
The Wireless PTZ Network Camera is not weatherproof. It needs to be equipped with a weatherproof case for outdoor use but it is not 
recommended for wireless camera.

2. When physically connecting the Network Camera to a network, what network cabling is required?
The Wireless PTZ Network Camera uses Category 5 UTP cable allowing 10 Base-T and 100 Base-T networking solutions.

3. Can the Network Camera be setup as a PC-cam on a computer?
No, the Wireless PTZ Network Camera is used only on an Ethernet or Fast Ethernet network. The D-Link DSB-C110, DSB-C310, can be 
used as a PC Camera (Webcam).

4. Can the Network Camera be connected to the network if it consists only of private IP addresses?
Yes, the Wireless PTZ Network Camera can be connected to a LAN using only a private IP address.

5. Can the Network Camera be installed and work if a firewall exists in the network?
If a firewall exists in the network, port 80 is open for ordinary data communication and HTTPS port 443 for . The DCS-5220 uses RTSP 
port 554, RTP port 556, and RTP port 558 for streaming audio and video. These ports (or the ports you have specified in the Setup Tab 
in the Configuration screen) need to be opened on the firewall.

6. Why am I unable to access the Network Camera from a web browser?
If a router or firewall is used on the network, the correct ports for the DCS-5220 may not be configured on the router or firewall. To correct 
the problem, you need to determine if the DCS-5220 is behind a router or firewall and if the router or firewall is properly configured for 
the ports the DCS-5220 is using. Refer to Page 38 for help in opening the correct ports on a router or firewall for use with the DCS-5220. 
Other possible problems might be due to the network cable. Try replacing your network cable. Test the network interface of the product 
by connecting a local computer to the unit.  If the problem is not solved, the Wireless PTZ Network Camera might be faulty.

7. Why does the Network Camera work locally but not externally?
•	 This might be caused by network firewall protection. The setting of the firewall may need to be changed in order for the Wireless PTZ 

Network Camera to be accessible outside of your local LAN. Check with the Network Administrator for your network.
•	 Make sure that your Wireless PTZ Network Camera isn’t conflicting with any Web server you may have running on your network.
•	 The default router setting might be a possible reason. Check that the configuration of the router settings allows the Wireless PTZ 

Network Camera to be accessed outside of your local LAN.
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Technical Specifications
NETWORK PROTOCOL SUPPORT
+ IPv4, TCP/IP, RTSP/ RTP/ RTCP, HTTP, SMTP, FTP, NTP, DNS, 

DHCP, UPnP, DDNS, PPPoE, IGMP, Samba client, IP Filtering, 3GPP

BUILT-IN NETWORK INTERFACES
+ 10/100BASE-TX Ethernet port, RJ45

VIDEO ALGORITHM SUPPORT
+ JPEG for still image
+ Compression: MJPEG & MPEG-4
+ Streaming: Simultaneous dual-streaming
+ MPEG-4 streaming over UDP, TCP, or HTTP
+ MPEG-4 multicast streaming
+ MJPEG streaming over HTTP
+ Supports 3GPP mobile surveillance
+ Camera live viewing for up to 10 clients

VIDEO RESOLUTION1

+ MPEG-4/MJPEG video resolution up to 640x480 (VGA)
+ Up to 30fps at 176 x 144
+ Up to 30fps at 320 x 240
+ Up to 30fps at 640 x 480

VIDEO FEATURES
+ Adjustable image size, quality, and bit rate
+ Time stamp and text overlays
+ 3 configurable motion detection windows
+ Flip & mirror
+ Configurable brightness, saturation, sharpness
+ Adjustable AWB

VIDEO BIT RATE
20K to 4M

SENSOR & LENS SPECIFICATIONS
+ 1/4” VGA CMOS sensor 
+ 4mm F2.0 standard fixed mount lens
+ Minimum illumination: 1Lux, F2.0
+ View angle: 48.45(Horizontal), 37.29(Vertical)

EVENT MANAGEMENT
+ Motion detection weekly schedule
+ Event notification and upload snapshots/video clips via HTTP, SMTP, or FTP
+ Multiple HTTP, SMTP, or FTP server setups
+ Multiple event notification setups for flexible application
+ Multiple recording methods for easier backup

SECURITY
+ Administrator and user group protected
+ Password authentication
+ HTTP and RTSP digest encryption
+ Remote client access allow / deny list

SURVEILLANCE SOFTWARE FUNCTIONS
+ Remote management/control of up to 32 cameras
+ Viewing of up to 32 cameras on one screen
+ Supports all management functions provided in web interface
+ Scheduled motion triggered, or manual recording options

REMOTE MANAGEMENT
+ Configuration accessible via web browser
+ Take snapshots/video clips and save to local hard drive or NAS via web browser

SYSTEM REQUIREMENTS
+ Operating System: Microsoft Windows 2000, XP, Vista

SUPPORTED PDA, MOBILE PHONES & SOFTWARE
Handsets with 3GPP player
+ Packet Video Player 3.0
+ QuickTime 6.5
+ Real Player 10.5
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1 4X digital zoom enlarges an image by magnifying the pixels in a selected portion of the image by 4 times.

Maximum wireless signal rate derived from IEEE Standard 802.11b/g specifications. Actual data throughput will vary. Network conditions and environmental factors, 
including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate. Environmental factors will adversely 
affect wireless signal range.

NETWORK INTERFACE
+ IEEE 802.3/802.3u 10/100BASE-TX Ethernet port
+ Supports half/full-duplex operations
+ Supports 802.3x Flow Control in full-duplex mode
+ Supports IEEE 802.3af PoE
+ 802.11b/g wireless with WEP/WPA/WPA2 security

AUDIO
+ Compression and bit rate:

- GSM-AMR speech compression, bit rate: 4.75 kbps ~12.2 kbps
- MPEG-4 AAC audio encoding, bit rate: 16 kbps ~128 kbps

+ Interface: internal microphone
+ Supports software audio mute

DIAGNOSTIC LED
2 color LEDs

POWER INPUT
100 - 240VAC, 50/60Hz, 12VDC, 1.25A

POWER CONSUMPTION
Max 4.8 W

DIMENSIONS
105 (W) X 105 (D) X 112 (H) (mm), 4.13” X 4.13” X 4.41” (without Antenna)

WEIGHT
650 grams

OPERATION TEMPERATURE
0o to 40o C (32o to 104o F)

STORAGE TEMPERATURE
-20o to 70o C (-4o to 158o F)

HUMIDITY
20% to 80% non-condensing

CERTIFICATIONS
+ FCC
+ CE
+ C-Tick

PACKAGE INCLUDES
+ DCS-5220 camera
+ External power adapter
+ CAT5 Ethernet cable
+ Quick Installation Guide
+ Master CD
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